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ABSTRAKT 

Sedimentace je přirozený proces, který je závislý na mnoha faktorech za působení 

času. Množství usazených sedimentů na dně vodních nádrží má vliv jednak na 

celkový objem a plochu vodního díla, ale také na reliéf dna.  

Tato práce se zabývá množstvím sedimentu ve vodní nádrži Fojtka a změnou reliéfu 

jejího dna za 109 let fungování nádrže. Pro účely této práce bylo na přehradě 

provedeno měření dna pomocí echosounderu z lodi, jehož výstupem byla bodová 

vrstva o 5500 bodech. Dále byla změřena břehová linie pomocí GPS přístroje. 

Zpracování dat proběhlo v programu ArcGIS, kde byla data nejdříve zredukována a 

upravena k použití pro interpolační nástroje ze sady ArcToolbox. Pro vybrání 

nejpřesnější interpolace byla vytvořena validační data, která byla porovnávána s 

interpolovanými. Nejlepší výsledky poskytovala interpolace Kriging a TIN v rozlišení 

0,5 m.  

Pro srovnání se současným stavem byly vektorizovány plány z doby výstavby, u 

kterých byla rovněž vytvořena validační data a následně porovnávána přesnost 

jednotlivých interpolací. Jako nejlepší metoda pro tato data byla vyhodnocena 

metoda TIN v rozlišení 0,5 m. Metoda TIN byla použita u obou datových sad pro 2D 

a 3D vizualizace reliéfu dna a také pro výpočet aktuálního objemu a plochy zátopy 

nádrže. 

Rozdíl reliéfů dna nádrže Fojtka ukázal zmenšení objemu nádrže o 6,7% a redukci 

zaplavené plochy o 3,2%. Vliv na toto relativně malé zanesení má pravidelně těžená 

předzdrž umístěná nad nádrží. 

 

Klíčová slova: GIS, echosounder, sediment, interpolace, batymetrie 

  



 

 

ABSTRACT 

Sedimentation in dams is a natural process depending on various factors over a 

period of time. Sediments influence both total capacity of dam’s surface and also 

relief of bottom.  

This thesis deals with amount of sediment in Fojtka dam and with change of its 

bottom’s relief in past 109 years since its establishment. There was conducted 

measuring using an echosounder in a boat. Final output derived from this 

experiment was a point layer including 5500 point items. Subsequently there was 

executed a measurement of dam's shoreline using GPS device. Data were 

processed in ArcGIS software, then reduced and edited to be used for interpolation 

tools of ArcToolbox. In order to select the most accurate interpolation method, there 

were created validation data, which were compared with interpolated data. The best 

results have been achieved by interpolation method Kriging and TIN in resolution 

0.5 m.  

Original maps were vectorized for comparison with current condition. Created 

validation data were compared in order to show accuracy of particular interpolation. 

The most useful evaluated method for gained data was TIN method in resolution 0.5 

m. TIN method was applied in both data sets for 2D and 3D bottom relief 

visualization and also for calculation of actual water volume and area of water 

surface of the dam.  

Difference in bottom’s relief of Fojtka dam showed capacity reduction about 6,7 % 

and reduction of water surface area about 3,2 %. Regular extracting of sediment in 

reservoir located above the dam causes this relatively small silting ratio. 

 

Key words: GIS, echosounder, sediment, interpolation, bathymetry 

 

  



 

 

Obsah 

1. Úvod ................................................................................................................................. 9 

2. Cíle práce ....................................................................................................................... 10 

3. Literární rešerše ............................................................................................................. 11 

3.1. Vznik sedimentu .................................................................................................... 11 

3.2. Podmínky vzniku sedimentu .................................................................................. 11 

3.3. Vlastnosti sedimentů .............................................................................................. 12 

3.4. Zanášení nádrží ...................................................................................................... 13 

3.5. Metody mapování vodních ploch ........................................................................... 14 

3.5.1. Letecké mapování ...................................................................................... 14 

3.5.2. Mapování z plavidla ................................................................................... 14 

3.5.2.1. Bodové mapování (singlebeam) ............................................................ 14 

3.5.2.2. Multibeam .............................................................................................. 15 

4. Metodika ........................................................................................................................ 16 

4.1. Řešená vodní nádrž ................................................................................................ 16 

4.2. Vektorizace ............................................................................................................ 17 

4.2.1. Získání dat ...................................................................................................... 17 

4.2.2. Vektorizace analogových map ....................................................................... 17 

4.3. Zaměření současného stavu nádrže ........................................................................ 19 

4.3.1. Měřící přístroj ................................................................................................ 19 

4.3.2. Postup měření ................................................................................................. 20 

4.3.2.1. Echosounder ........................................................................................... 20 

4.3.2.2. GPS přístroj ............................................................................................ 21 

4.3.3. Zpracování naměřených dat ........................................................................... 21 

4.3.3.1. Data naměřená echosounderem.............................................................. 21 

4.3.3.2. Data naměřená GPS přístrojem .............................................................. 23 

4.4. Tvorba DTM dna nádrže ........................................................................................ 24 

4.4.1. Příprava dat pro interpolaci ............................................................................ 24 

4.4.1.1. Data 1906 ............................................................................................... 24 

4.4.1.2. Data 2015 ............................................................................................... 27 

4.4.2. Hodnocení interpolačních metod ................................................................... 29 

4.4.3. Vyhodnocení interpolačních metod ............................................................... 31 

4.4.3.1. Datová sada 1906 ................................................................................... 32 

4.4.3.2. Datová sada 2015 ................................................................................... 34 

4.5. Množství sedimentu v nádrži ................................................................................. 36 



 

 

4.6. Odchylka interpolace ............................................................................................. 37 

4.7. Vizualizace ............................................................................................................. 39 

4.7.1. Porovnání reliéfů dna ..................................................................................... 39 

5. Výsledky práce ............................................................................................................... 41 

6. Diskuze .......................................................................................................................... 43 

7. Závěr .............................................................................................................................. 46 

8. Přehled literatury a použitých zdrojů ............................................................................. 47 

9. Přílohy ............................................................................................................................ 50 



9 

 

1. Úvod 

 

Ať už mluvíme o přehradách nebo malých vodních nádržích (rybnících), jejich 

vybudování byl drastický zásah do krajiny, při kterém došlo ke zničení některých 

biotopů. Na druhou stranu se nově vybudované nádrže staly novým domovem pro 

řadu rostlin a živočichů (Cítek a kol., 1999). Vodní nádrže se staly součástí 

hydrologického systému krajiny. Dobrým obhospodařováním se značně zlepšovaly 

odtokové poměry, staly se zdrojem vody a také velmi důležitou roli hrála ochrana 

před velkými vodami (Vojtěch, 1996). 

V současnosti je v souvislosti s vodními nádržemi spojeno několik problémů, které 

je třeba řešit. Jedním z těchto problémů je zanášení vodních nádrží sedimenty. 

Sedimenty ovlivňují jednak kvalitu vody, ale hlavně retenční schopnost nádrží. Počet 

malých vodních nádrží a rybníků na našem území je odhadován na přibližně 25 

tisíc, což představuje plochu 52 tisíc hektarů. Teoretický objem vody všech těchto 

nádrží je zhruba 600 milionů m3. Celou jednu třetinu z tohoto množství představují 

sedimenty uložené na dně (Gergel, 1997). Otázka odbahnění je však ekologicky, 

technicky ale hlavně finančně velmi náročná. Náklady na odbahnění se pohybují 

v průměru okolo 1000 kč za 1m3 sedimentů (Beran, 2006), což dělá 200 miliard 

korun pro odbahnění nádrží na území ČR.  

Velký vliv na množství sedimentů putujících vodními toky přes vodní nádrže má 

člověk. Velmi skloňovaným pojmem je v tomto případě landuse. Hospodaření 

v krajině, hlavně smyvy ze zemědělsky obdělávané půdy jsou klíčové pro rozsah 

eroze a následný pohyb půdních částic níže po pozemku nebo přímo do vodního 

toku. Proces sedimentace začíná rozrušením hornin či půdy, unášením 

a přenášením erodovaných částic a následně jejich uložením. K ukládání sedimentů 

ve vodních nádržích (tocích) dochází při snížení rychlosti proudění toku, proto jsou 

vodní nádrže velmi ohroženy (Šálek a kol., 1989). 

S příchodem 3D modelování povrchu se tato metoda začala využívat 

i pro mapování reliéfu dna přehrad a nádrží z důvodu řešení environmentálních 

problémů. Jednou z možností využití tohoto modelování je analyzování změn reliéfu 

dna, změny ploch hladin a hlavně změny zásobního prostoru nádrže. Tyto změny 

jsou podmíněné vícero faktory, hlavně se jedná o zmíněné zanášení a sedimentaci 

(Weis a Kubinský, 2014).  
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2. Cíle práce 

 

Analýza změn reliéfu dna a zásobního prostoru přehrady Fojtka za působení času, 

je cílem této práce. Porovnán bude reliéf dna přehrady Fojtka z doby výstavby 

(1906) a současný reliéf dna (měření listopad 2015). Budou vizualizovány 2D i 3D 

modely pro oba porovnávané stavy. Pro dosažení co nejpřesnějších výsledků bude 

vypracováno podrobné srovnání interpolačních metod nabízených programem 

ArcGIS. Rovněž bude vypracována podrobná metodika popisující všechny kroky 

pro analýzu změn reliéfu dna a zásobního prostoru nádrže. Zhodnocení míry 

zanesení nádrže poskytne přehled objemu a plochy zátopy pro stanovenou hodnotu 

nadmořské výšky hladiny. 

 Analýza změn reliéfu dna a zásobního prostoru přehrady Fojtka 

 Srovnání reliéfů dna z doby výstavby (1906) a současného reliéfu dna 

(11/2015) 

 2D a 3D vizualizace pro oba porovnávané stavy 

 Hodnocení interpolačních metod nabízených softwarem ArcGIS na použitých 

datech 

 Metodika pro analýzu změn reliéfu dna 

 Zhodnocení míry zanesení a změny plochy zátopy na VD Fojtka  
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3. Literární rešerše 

 

3.1. Vznik sedimentu 

 

Přehradní nádrže a rybníky představují ideální pasti pro suspendovaný říční 

materiál. Rychlost sedimentace je ovlivněna hlavně množstvím přinášeného 

materiálu. Vliv na rychlost sedimentace má mnoho faktorů, hlavně velikost řešeného 

povodí, typ hornin ve sběrné oblasti, hustota odvodňování, sklon svahů a míra 

lidských zásahů v povodí. Přínos sedimentů je ovlivněn rovněž množstvím 

a sezónní distribucí srážek, rozmístěním a typem vegetačního pokryvu. Přehradní 

sedimenty poskytují kontinuální záznam sedimentace od doby napuštění, jejich 

mocnost s časem narůstá a dochází tak k postupnému zanášení nádrže. Studiem 

těchto sedimentů lze sledovat časové posloupnosti procesů a událostí 

zaznamenaných v sedimentu, mezi něž patří historie kontaminace, cyklické změny 

a výkyvy klimatu (Bell, 1998).  

 

3.2. Podmínky vzniku sedimentu 

 

Střetem srážkových vod a půdního prostředí dochází erozním působením vody 

k narušení povrchových profilů a odnosu půdních částic. Velikost a hmotnost 

smývaných částic odpovídá intenzitě erozních jevů. Povrchovým odtokem 

se současně dávají do pohybu i látky rozpuštěné a navázané na povrchu částic. 

Významné poškození zemědělských pozemků, ztráty půdy z ploch povodí 

a i zanášení vodních nádrží je způsobováno extrémními erozními stavy (Dostál 

a kol. 2003).  

Pohyb splavenin a plavenin povrchovými toky je závislý na unášecí síle (rychlosti 

proudění vody). Jakmile voda protéká nádrží, dochází ke snížení průtočné rychlosti 

hydrosuspenze a následnému usazovaní částic. Ukládání sedimentů v nádržích je 

součástí složitých přenosových jevů proměnných v prostoru a času.   
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3.3. Vlastnosti sedimentů 

 

Podle velikosti částic se v systému rozlišují hrubé frakce a jemné podíly. Tuhou fázi 

zvodnělých usazenin tvoří: 

 Anorganické podíly -  jílové a prachové částice včetně přírodních uhličitanů 

 

 Organické podíly – zbytky rostlinných tkání a organického hnojení v různém 

stupni dekompozice 

 

 Antropicky navýšené chemické látky – agrochemikálie, biocidy, vápenatá 

korektiva, imisní zátěže 

Vlastnosti usaditelných látek jsou vázány na vzájemné vztahy mezi disperzním 

prostředím a disperzní fází, ve které se objevují hlavně hlinitokřemičitany, 

hydratované oxidy manganu, hliníku a železa a organické látky v různé fázi 

přeměny. Půdní částice splavenin podléhají hydrataci, hydrolýze a sekundárním 

přeměnám vyvolaným výměnami iontů a redukcí, přičemž modifikující přeměny 

alumosilikátů s vrstevnatou strukturou jsou méně výrazné než u živců a dalších 

hlinitokřemičitanů s trojrozměrnou strukturou. Chemická i biochemická redukce 

ovlivňuje formy výskytu, rozpustnost a migraci jednotlivých složek v profilu dnového 

matrixu. Vlastnosti sedimentu se mění stářím. Modifikovaným formám se mění 

prostorové uspořádání krystalů, struktura a následně i sorpční kapacita. Distribuce 

a poměrné zastoupení různých forem existence produktů přeměn určují konečné 

fyzikální a chemické vlastnosti sedimentu. 

Obecně je sediment jemná porézní směs složená z částic různého tvaru a velikosti. 

Hodnota objemové hmotnosti má dosti široký rozsah, který je závislý na druhu 

usazenin a také podmínkách ukládání. Dalším faktorem ovlivňujícím hustotu 

sedimentu je separace, obsah jílu a prachu, hydratační obaly iontů a mezivrstevná 

adsorpce vody. Fyzikální a chemické vlastnosti smyvů jsou do jisté míry závislé 

na textuře, obsahu a druhu organických látek, staří a druhu usazenin. 

Za charakteristické znaky sedimentů jsou považovány textura, aktuální vlhkost, 

vododržnost a obsah organických látek. Intenzita vodní eroze je závislá na stupni 

disperze agregátů, vzájemném oddělení půdních částeček a udržení tohoto stavu 

během transportu. Rychlost sedimentačních jevů je určena dle stupně oddělení 

hrubých půdních částic a poměrného množství jednozrnných podílů se stejným 
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průměrem půdních částic. Finální hodnoty usazených zrnitostních frakcí jsou dány 

podmínkami transportu a způsobu ukládání transportovaných půdních částic. 

Pro určení množství jsou klíčovými informacemi základní fyzikální parametry 

(objemová hmotnost a z ní odvozená pórovitost, která vyjadřuje objem pórů 

k celkovému objemu usazenin). Dostál a kol. 2003. 

 

3.4. Zanášení nádrží 

 

Pro určení celkového transportu sedimentu z povodí by bylo v ideálním případě 

přímé měření, které ovšem není možné zrealizovat. Žádný model nepopisuje reálný 

stav systému a transport sedimentu z povodí je tak komplexní jev, že jej lze jen 

velmi přibližně modelovat (Krása a kol., 2013). 

Na základě zkušeností s používáním rovnice USLE (univerzální rovnice pro výpočet 

průměrné dlouhodobé ztráty půdy z pozemků) došlo k její aktualizaci a úpravě. Byly 

změněny způsoby stanovení jednotlivých faktorů rovnice a byla pojmenována 

na RUSLE (revidovaná univerzální rovnice ztráty půdy). Rovnice RUSLE vyžaduje 

proti rovnici USLE větší množství vstupních dat, což vede k přesnějším výsledkům, 

ale na druhou stranu se mohou vyskytnout problémy s jejich získáním. Výhodou je 

možnost použití databází (zatím jen pro USA), které značně zpřesňují a usnadňují 

výpočet pomocí kombinací vegetačního pokryvu, druhu agrotechnických operací 

a různých klimatických podmínek (Janeček a kol, 2008).  

Velká část erodovaného materiálu se zachytí již při zpětné sedimentaci 

na pozemcích a dále v povodí. Z toho důvodu celková ztráta půdy vypočtená 

metodou USLE výrazně převyšuje množství splavenin. Celkové množství splavenin 

odnesené z povodí se označuje jako „sediment yield“ (Krása a kol., 2013).  

Pro určení množství splavenin transportovaných až do uzávěrového profilu povodí 

je třeba zjistit poměr zachycení (trap efficiency) – TE (%). Po zjištění těchto údajů je 

možné stanovit, kolik t/rok (m3/rok) splavenin zachytí daná nádrž a kolik jich 

pokračuje dále do povodí.  
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3.5. Metody mapování vodních ploch 

 

3.5.1. Letecké mapování 

 

Mapování v blízkosti vodních ploch je závislé na dvou faktorech. Buď je požadováno 

mapování vodní hladiny (rozsah zátop) nebo mapování dna pod vodní hladinou. 

Pro každý z těchto úkonů je třeba použít lidar s jinou vlnovou délkou laserového 

záření. Voda pohlcuje infračervené záření, které je využito při mapování zátop. 

Pro mapování terénu pod vodní hladinou je použito zelené nebo modrozelené 

spektrum, které vodou není pohlcováno a může se tedy odrazit ode dna zpět 

k přístroji.   V praxi se využívají duální systémy, kdy je vysíláno jak intračervené, tak 

i zelenomodré (Obrázek č. 1). Systém se nazývá DIAL – Differential Absorption 

Lidar (Browell 1998).  

 

Obrázek 1: Systém DIAL pro mapování vodních ploch (Zdroj: Optech) 

Systém tedy mapuje v jednom okamžiku hranice vodní hladiny a dno. U velmi čisté 

vody lze mapovat dno až do 50 m hloubky (Boselli a kol. 2014). 

3.5.2. Mapování z plavidla 

3.5.2.1. Bodové mapování (singlebeam) 

 

Echo sounder využívá odrazivosti zvukových vln ke stanovení vzdálenosti objektu 

(terénu), ke kterému je vysílán. Vychází se z rychlosti zvuku ve vodě (přibližně 1500 

m/s) a času za který se vyslaná zvuková vlna vrátí (Jong 2002). U bodového 

mapování (singlebeam) je vždy měřena hloubka v jednom místě (Obrázek č. 2).   
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Obrázek 2: Porovnání singlebeam a multibeam mapování (zdroj: http://what-when-how.com/) 

 

3.5.2.2. Multibeam 

 

Stejně jako singlebeam využívá multibeam zvukových signálů s tím rozdílem, 

že multibeam dokáže zpracovat najednou desítky až stovky bodů, což rapidně 

snižuje čas a náklady měření (Glen 2015). Obvykle je měřen široký pás bodů kolmý 

na směr plavby (Obrázek č. 3).  

 

Obrázek 3: Multibeam mapování dna (zdroj: www.navi.mil) 

 

http://what-when-how.com/
http://www.navi.mil/
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4. Metodika 

4.1. Řešená vodní nádrž 

 

Údolní nádrž Fojtka (Obrázek č. 4) byla vybudována na potoce Fojtka 

ve stejnojmenné obci v letech 1904 – 1906. Tehdejším investorem bylo Vodní 

družstvo se sídlem v Liberci. Stabevní práce započaly 11. května 1904 a prováděla 

je firma H. Rella und Ko. z Vídně.  

Účelem vodního díla je zmírnění velkých vod, částečná ochrana území ležícího 

pod vodních dílem (povodí Jeřice) před velkými vodami, zajištění minimálního 

zůstatkového průtoku pod vodních dílem ve výši 25 l/s, nadlepšení průtoků pod 

vodním dílem při havarijním znečištění v Jeřici a rekreace – rybolov a další vodní 

sporty. 

Přehradní hráz je gravitační, zděná z lomového kamene, obloukového půdorysu 

o poloměru křivosti 175 m. Návodní líc je od základů až po kótu 389,10 m n. m. 

svislý a odtud až po korunu hráze ve sklonu 10:1. Sklon vzdušného líce se mění 

plynule. Pro převádění velkých vod slouží nehrazený korunový přeliv opatřený třemi 

poli o maximální kapacitě 19,39 m3/s, který je situován uprostřed hráze. Skluz 

přelivů je ukončen ve vývaru společném i pro výpusti. Pro převedení běžných 

průtoků a pro manipulaci s objemem vody v nádrži slouží dvě spodní výpusti 

o průměru 80 cm umístěné v příčných štolách hráze u dna údolí. Obě výpusti jsou 

opatřeny dvěma uzávěry, na návodní straně je revizní tabule ovládaná 

z manipulační věže a na vzdušné straně regulační šoupě ovládané z manipulačního 

domku. Kapacita obou výpustí je stanovena na 9,37 m3/s. 

 

Obrázek 4: Letecký snímek VD Fojtka (zdroj: www.nebeske.cz) 
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4.2. Vektorizace  

4.2.1. Získání dat 

 

Od povodí Labe (pobočka Jablonec nad Nisou) bylo získáno povolení na prohlídku 

dostupných materiálů v archivu. Projektová dokumentace k vodnímu dílu Fojtka byla 

ve velmi dobrém stavu a podařilo se dohledat situační vrstevnicovou mapu terénu 

před napuštěním přehrady v měřítku 1:1000. Mapa obsahovala krok vrstevnic 0,5 m, 

což poskytovalo dostatečnou přesnost pro následnou práci (Obrázek č. 5). 

 

Obrázek 5: Analogová mapa z roku 1906 

 

4.2.2. Vektorizace analogových map 

 

Vzhledem k tomu, že materiály nebylo možné vynést z archivu a kvalitně oskenovat, 

byly ofoceny na místě digitální zrcadlovkou. Vektorizace byla nejdříve provedena 

přes nástroj ArcScan, který je obsažen v programu ArcGIS. Mapa byla nejdříve 

exportována jako dvoubarevná bitmapa (bmp - monochrome) a poté nahrána 

do ArcMap přes nabídku Add Data. V Layer Properties bylo třeba změnit symboliku 

na Unique values, tak aby pozadí bylo bílé. Pravým kliknutím na záhlaví byl 

z kontextového menu vybrán nástroj ArcScan. K fungování nástroje ArcScan je 

třeba mít zapnutou editaci (pravý klik na vrstvu -> Edit Features). Automatická 
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vektorizace byla spuštěna tlačítkem Vectorization -> Generate Features. 

Vektorizace poskytovala velmi špatné výsledky, jelikož vrstevnice ve větších 

sklonech byly pro program špatně rozeznatelné. Opravy, které by bylo třeba ručně 

dodělat, by byly tak rozsáhlé a tím pádem zdlouhavé, že bylo rozhodnuto 

o kompletní manuální vektorizaci. 

Rastrový obrázek s vrstevnicovou mapou byl nahrán jako podkladová vrstva 

do ArcMap poté pomocí nástroje Georeferencing (pravý klik na záhlaví -> 

Georeferencing) nastaven do správné pozice orientací i měřítkem. Postup byl 

takový, že byl nejprve v rolovací nabídce nástroje Georeferencing vybrán rastr 

s vrstevnicemi VD Fojtka, poté byly pomocí ikony Add Control Points přiřazeny body 

z rastru k bodům podkladové mapy tak, aby rastr co nejpřesněji odpovídal reálné 

situaci. Byla vytvořena vrstva “Vektorizace_vrstevnic“ (pravý klik na složku 

v Catalogu -> New -> Shapefile -> vyplněn název -> Polyline -> S-JTSK Krovak East 

North -> OK), která byla následně editována (pravý klik na “Vektorizace_vrstevnic“ -

> Edit Features -> Start Editing). Vrstevnice byly tímto způsobem manuálně 

vektorizovány (Obrázek č. 6) a byly jím přiřazeny nadmořské výšky. Nejdříve byl 

vytvořen sloupec “VYSKY“ (pravý klik na vrstvu “Vektorizace_vrstevnic“ -> Open 

Attribute Table -> Table Options -> Add Field -> vyplněn název -> Type: double -> 

OK). Tlačítkem Select Features z hlavní nabídky byly vybrány vektorizované 

vrstevnice vždy se stejnou nadmořskou výškou a v atributové tabulce jim byla 

nadmořská výška doplněna (v atributové tabulce ikona Show selected records -> 

označen sloupec “VYSKY“ -> pravý klik na “VYSKY“ -> Field Calculator -> vyplněna 

nadmořská výška). Bližší studium hodnot nadmořských výšek ukázalo, že v době 

vzniku tohoto materiálu byl použit jadranský výškový systém. V současnosti je 

používán už jen výškový systém Balt po vyrovnání (Bpv). Od hodnot nadmořských 

výšek bylo odečteno 0,4 m (polohu pro ČR platí -0,38 až -0,42 m), a tím bylo 

dosaženo ekvivalentu výškového systému Balt po vyrovnání (Pravda a Kusendová, 

2007). 
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Obrázek 6: Vektorizované vrstevnice (vizualizace ArcScene) 

 

4.3. Zaměření současného stavu nádrže 

 

4.3.1. Měřící přístroj 

 

Pro měření batygrafie přehrady Fojtka byl použit echosounder Riversurveyor M9 

(Obrázek č. 7) instalovaný do dvoumístného kajaku. Byl použit softwarový klíč 

Riversuveryor určený pro měření na tocích, který je taktéž použitelný i pro měření 

hloubek nádrží.  Pro určování polohy měření byla s echosounderem spárována GPS 

stanice. Technické parametry jsou uvedeny na obrázku č. 8.  

 

  

Obrázek 7: vlevo pohled na hlavici echosounderu M9, vpravo již umístěn v lodi  
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Obrázek 8: Technické parametry echosounderu M9 (Erdem 2013) 

4.3.2. Postup měření 

 

4.3.2.1. Echosounder 

 

Na břehu byla rozložena pevná GPS stanice, která určovala polohu echosounderu 

při jeho měření, poté byl echosounder umístěn do lodi a byla provedena kontrola 

spárování GPS a echosounderu. Před začátkem měření bylo nutné echosounder 

kalibrovat na měření tak, že byl po dobu 90 vteřin otáčen dokola a nakláněn 

ze strany na stranu. Veškeré nastavení měření i kalibrace bylo provedeno pomocí 

přiloženého mobilního telefonu. Po kalibraci se ještě nastavil ponor lodi dle 

hmotnosti obsluhy lodi. Jakmile bylo spuštěno měření, echosounder začal ukládat 

každou vteřinu naměřená data. Nejdříve byla naměřena břehová linie, tak blízko 

břehu, jak jen dovolovala hloubka. Poté byla přehrada najížděna od přítoku k hrázi 

postupně napříč. Nakonec se nádrž najela podélně v půlce a ve čtvrtinách (Obrázek 

č. 9). Tímto postupem měření se dosáhlo nejefektivnějšího pokrytí měřených dat. 

Na nádrži o rozměrech přibližně 400 x 130 m bylo naježděno 7,5 km. Celkový počet 

naměřených bodů činil 5500.  
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Obrázek 9: Průběh měření na VD Fojtka 

 

4.3.2.2. GPS přístroj 

 

Mobilní GPS přístroj byl potřeba hlavně kvůli přesnému zaměření nadmořské výšky 

hladiny v době měření, jelikož echosounder zaměřuje hloubky, nikoliv nadmořskou 

výšku dna. Při této příležitosti byl využit i pro zaměření břehové linie a bodů na ní 

kolmých. Bohužel se nepodařilo zaměřit celou břehovou linii z důvodu zhoršující 

se přesnosti měření, která je u tohoto typu přístroje závislá na okolním terénu, 

vegetaci a z toho vyplývající dostupnosti družic. Při udržení polohové i výškové 

přesnosti do 2 cm bylo naměřeno 30 bodů. 

 

4.3.3. Zpracování naměřených dat 

 

4.3.3.1. Data naměřená echosounderem 

 

Data z echosounderu byla exportována v programu dodávaném výrobcem 

do formátu .xlsx, ve kterém byly obsaženy sloupce se souřadnicemi, zaměřenou 
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hloubkou a dalšími údaji, které nebyly ke zpracování dat důležité. Sloupce s X a Y 

souřadnicí byly zkopírovány do textového dokumentu (.txt). Souřadnice byly 

v souřadnicovém systému WGS 84/UTM 33N, jehož převedení na S-JTSK Křovák 

East North bylo provedeno v ArcMap. Od nadmořské výšky získané GPS přístrojem 

v době měření (388,52 m n. m) byly odečteny hloubky stanovené echosounderem 

a takto upravená data byla zkopírována do textového souboru jako 3. sloupec 

(Obrázek 10).  

 

Obrázek 10: Vytvořený textový dokument s daty z měření echosounderem 

V dalším kroku zpracování dat byl proveden import tohoto souboru pomocí hlavní 

nabídky v ArcMap File-> Add data -> Add XY Data -> vybrán .txt soubor -> přiřazeny 

názvy sloupců k souřadnici X, Y a Z -> zvolen souřadnicový systém WGS 1984 

UTM Zone 33N -> OK. Vrstva byla uložena jako shapefile (pravý klik na vrstvu-> 

Data -> Export Data -> this layer´s source data -> vyplněno umístění a název 

souboru -> OK). Takto exportovaná data byla posunuta od skutečného stavu o cca 

130 m, a proto byla po opětovném načtení z ArcCatalogu (ArcMap sám nabídne 

tranformaci) transformována pomocí Transformation -> Convent from -> 

GCS_WGS_1984 -> into -> GCS_S_JTSK_-> Using -> S_JTSK_TO_ WGS_1984_1 

(Obrázek č. 11). 
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Obrázek 11: Transformace souřadnicového systému WGS 1984 na S-JTSK 

 

4.3.3.2. Data naměřená GPS přístrojem 

 

Data z GPS byla exportována v programu xxx do formátu .xlsx, ve kterém byly 

obsaženy sloupce se souřadnicemi, nadmořskou výškou, přesností měření a datem 

měření. Pro import dat do ArcMap byla použita data s přesností pod 2 cm. Z těchto 

selektovaných dat byly zkopírovány sloupce s X a Y souřadnicí, které byly 

vynásobeny -1 pro správně zobrazení v souřadnicovém systému “JTSK Křovák East 

North“. Dále byl zkopírován sloupec s nadmořskou výškou. Tyto tři sloupce byly 

vloženy do textového souboru .txt (Obrázek č. 12), a následně byl proveden import 

tohoto souboru pomocí hlavní nabídky v ArcMap File-> Add data -> Add XY Data -> 
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vybrán .txt soubor -> přiřazeny názvy sloupců k souřadnici X, Y a Z. Vrstva byla 

uložena jako shapefile (pravý klik na vrstvu-> Data -> Export Data -> this layer´s 

source data -> vyplněno umístění a název souboru -> OK). 

 

Obrázek 12: Vytvořený textový dokument s daty z měření GPS 

 

4.4. Tvorba DTM dna nádrže 

 

4.4.1. Příprava dat pro interpolaci 

 

4.4.1.1. Data 1906 

 

Liniová vrstva zvektorizovaných vrstevnic by nemohla být použita pro rastrovou 

interpolaci, jelikož vstupem pro interpolační nástroje obsažené v ArcGIS je bodová 

vrstva (výjimku tvoří nástroj Topo to Raster). Převod vrstevnic na bodovou vrstvu byl 

nejdříve proveden pomocí nástroje “Feature Vertices To Points“ nebo také “Split 

Line at Point“, kde byly vstupními vrstvami vrstevnice a výstupní bodová vrstva. 

Hustotu bodů na linii není možné volit, nástroje generují tzv. vertex body (vrcholy), 

což jsou body, ze kterých vznikla linie vektorizací. Samozřejmě, čím bude bodová 

vrstva hustější, tím přesnější budou výsledná data. Jednou z možností, jak zvýšit 

počet bodů je manuální přidání bodů, které je ale v tomto případě velmi zdlouhavé 
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(pravý klik na vrstevnice -> Edit Features ->Start Editing -> Continue -> zvolena linie 

-> Edit Vertices -> Add Vertex), jelikož počet nových bodů pro dostatečnou hustotu 

bodové vrstvy by byl v řádu tisíců. Pro tyto účely byl vytvořen nástroj 

pomocí programovacího jazyka Python, který generuje body v zadané vzdálenosti. 

Pro skript (Obrázek č. 13) bylo vytvořeno uživatelské prostředí (Obrázek č. 14), 

ve kterém je vstupní vrstvou liniová vrstva, poté je vyplněna vzdálenost jednotlivých 

bodů na linii a nakonec uživatel zadá umístění a název výstupní bodové vrstvy. 

 

Obrázek 13: Skript pro vytvoření bodů v požadované vzdálenosti z liniové vrstvy 
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Obrázek 14: Uživatelské prostředí vytvořeného nástroje 

 

Pomocí nástroje byla vrstevnicová data převedena na bodovou vrstvu v metrovém 

rozestupu bodů. Dalším krokem bylo definování hráze. Nejdříve byla vytvořena linie 

s korunou hráze a poté návodní násyp hráze. Linie byly opět pomocí nástroje 

rozděleny po metru. Nástrojem “Merge“ (Geoprocessing -> Merge -> vstupní bodové 

vrstvy – hráz a linie, zadán název výstupní spojené bodové vrstvy) byly vytvořené 

bodové vrstvy spojené do jedné (nutný stejný název sloupců pro správné sloučení 

i atributové tabulky). Takto připravená bodová vrstva byla přes nástroj “Create TIN“ 

převedena do nepravidelné sítě (TIN), tvořené nepřekrývajícími se přilehlými 

trojúhelníky, kdy každý z vrcholů se souřadnicemi x, y, z je nositelem výškové 

hodnoty. Převod do TIN (Obrázek č. 15) byl proveden pro kontrolu bodové vrstvy, 

jelikož TIN nevyhlazuje extrémní hodnoty, takže jsou případné nežádoucí body 

velmi dobře patrné. Dále bylo zkontrolováno modelování hráze a její napojení 

na bodovou vrstvu vytvořenou z vrstevnic. Takto upravená data byla připravena 

pro vstup do intepolačních nástrojů. 
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Obrázek 15: Vygenerovaný TIN a bodová vrstva, ze které byl vytvořen (oblast u hráze) 

 

4.4.1.2. Data 2015 

 

Bodová vrstva z naměřených dat byla dostatečně hustá, ale kvůli nízkému stavu 

vody v nádrži nebylo možné zaměřit nádrž kompletně celou. Pro účely této práce 

byla použita WMS - DMR 5G data terénu od ČUZK a následně použita pro doplnění 

údajů břehů a přilehlých strání. Dalšími pomocnými daty pro co nejpřesnější 

výsledky bylo vlastní měření GPS přístrojem. Tyto 3 bodové vrstvy byly spojeny 

v jednu (nástrojem “Merge“ (Geoprocessing -> Merge -> vstupní bodové vrstvy – 

měření echosounderem, 5G a měření GPS přístrojem, zadán název výstupní 

spojené bodové vrstvy), která reprezentovala stav reliéfu dna a přilehlých břehů. 

Přehled pokrytí jednotlivých vrstev je zobrazen na Obrázku č. 16. 
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Obrázek 16: Pokrytí dat v zájmovém území (červeně měření echosounderem, zeleně WMS - DMR 5G a 

modře GPS přístroj) 

 

Takto připravená bodová vrstva byla opět přes nástroj “Create TIN“ převedena 

do TIN. Vizuální kontrolou byly odhaleny extrémní a nesmyslné hodnoty, které byly 

smazány v režimu editace. Takto upravená data byla připravena pro vstup 

do interpolačních nástrojů. 
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Obrázek 17: Vygenerovaný TIN a bodová vrstva, ze které byl vytvořen (oblast u přítoku) 

 

 

4.4.2. Hodnocení interpolačních metod 

Hodnocení interpolačních metod pro datové sady (1906 a 2015) bylo provedeno 

na základě statistických údajů vzniklých porovnáním interpolovaných hodnot 

a hodnot známých (naměřených) ve stejném místě. Pro tyto účely bylo vybráno 200 

náhodných bodů (skupiny, řady, shluky, jednotlivé body) pro každou datovou sadu. 

Tyto body byly před vstupem datové sady do interpolačních metod vymazány 

(Obrázek č. 18).  
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Obrázek 18: Přehled vybraných kontrolních bodů 

Každá metoda interpoluje v místech chybějících bodů určitou hodnotu, která bude 

srovnána se známou hodnotou odpovídající smazanému bodu. Pro porovnání 

rozdílů vytvořených rastrů a kontrolní bodové vrstvy byl použit nástroj “ Extract 

Values to Points“ (ArcToolbox -> Spatial Analyst Tools -> Extraction -> Extract 

Values to Points). Výstupní data z tohoto nástroje obsahují v atributové tabulce 

hodnotu jednotlivých bodů bodové kontrolní vrstvy a také odpovídající hodnotu 

interpolovaných pixelů rastru. Do nového sloupce, který byl vytvořen, byl pomocí 

Field Calculatoru vypočítán rozdíl hodnot v absolutní hodnotě (Obrázek č.19).  
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Obrázek 19: Prostředí Field Calculatoru a vzorec pro výpočet základu RMSE 

Tento rozdíl byl nasčítán ze všech 200 kontrolních bodů a následně podělen počtem 

bodů. Statistika každé intepolační metody byla dostupná v atributové tabulce (pravý 

klik na název sloupce -> Statistics), kde byly dostupné údaje pro další zpracování 

v MS Excel. Tímto postupem byla vypočítána hodnota RMSE, která byla stanovena 

pro každou interpolační metodu. Nejpřesnější interpolační metoda pro tento soubor 

dat byla určena dle nejmenší hodnoty RMSE. 

 

4.4.3. Vyhodnocení interpolačních metod 

Pro každou interpolační metodu (rozdělení každé ještě na 4 druhy rozlišení 

generovaného rastru) byla zpracována statistika RMSE (střední kvadratické chyba, 

měří rozptyl rozdělení četnosti odchylek mezi původními výškovými daty a daty 

vygenerovaného DMT), směrodatné odchylky a pořadí dle nejmenšího RMSE. Toho 

pořadí ovšem ještě neurčuje nejvhodnější interpolaci (viz. níže). 
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4.4.3.1. Datová sada 1906 

Data vzniklá pro rekonstrukci stavu reliéfu dna z roku 1906 byla specifická tím, 

že byla vytvořena z vektorizovaných vrstevnic, což znamená, že pokrytí body nebylo 

rovnoměrné, ale dané pokrytím vrstevnic. 

Porovnáván byl zejména rozptyl rozdělení četnosti odchylek mezi původními 

výškovými daty a daty vygenerovaného DMT (RMSE). Čím více se tato hodnota 

blíží k nule, tím přesněji interpolovala daná metoda data (Tabulka č. 1).  

Název interpolace 
Rozlišení 

rastru 
RMSE 

Směrodatná 

odchylka 
Pořadí 

Topo to raster 

0.5 0.11 0.16 8 

1 0.11 0.19 11 

2 0.13 0.15 12 

5 0.25 0.26 19 

TIN 

0.5 0.05 0.06 2 

1 0.07 0.08 6 

2 0.11 0.13 9 

5 0.24 0.27 18 

Spline 

0.5 0.05 0.06 1 

1 0.06 0.07 4 

2 0.11 0.12 10 

5 0.21 0.25 17 

Kriging 

0.5 0.05 0.06 3 

1 0.06 0.07 5 

2 0.10 0.11 7 

5 0.21 0.25 16 

IDW 

0.5 0.14 0.16 13 

1 0.14 0.16 14 

2 0.17 0.20 15 

5 0.26 0.30 20 

Tabulka 1: Přehled interpolačních metod testovaných na datech z roku 1906 

 

Jak již bylo zmíněno, nízká hodnota ještě neukazuje na nejlepší metodu. Pro tyto 

data bylo nejnižší RMSE u metody Spline pro rozlišení rastru 0,5 m. Po vizuální 

kontrole je však jasné, že tato metoda pro tento typ dat není vůbec vhodná. 

Nerovnoměrným rozložením dat vznikají velmi extrémní hodnoty interpolovaných 

dat (Obrázek č. 20). V tělese hráze je patrná oblast, kde byly vyinterpolovány 

hodnoty převyšující 400 m n. m. (koruna hráze má nadmořskou výšku 393,1 m).  
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Obrázek 20: Vizualizace intepolační metody Spline na datech z roku 1906 

Jako druhá nejlepší interpolační metoda dle RMSE vychází interpolace TIN 

pro rozlišení rastru 0,5 m. Tato metoda se jeví velmi dobře i po vizuální stránce 

(Obrázek č. 21). TIN (nepravidelná trojúhelníková síť) je původně vektorová metoda, 

která byla přes nástroj “TIN to Raster“ převedena na rastr, aby mohla být 

vyhodnocena jako ostatní interpolační metody.  
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Obrázek 21: Vizualizace intepolační metody Spline na datech z roku 2015 

4.4.3.2. Datová sada 2015 

 

Datová sada roku 2015 obsahovala více jak 5500 bodů naměřených 

echosounderem a dalších několik tisíc v okolí nádrže. Pokrytí body bylo mnohem 

rovnoměrnější, což se projevilo na výsledcích porovnávaných interpolačních metod.  

Porovnáván byl zejména rozptyl rozdělení četnosti odchylek mezi původními 

výškovými daty a daty vygenerovaného DMT (RMSE). Čím více se tato hodnota 

blíží k nule, tím přesněji interpolovala daná metoda data (Tabulka č. 2).  
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Název interpolace 
Rozlišení 

rastru 
RMSE 

Směrodatná 

odchylka 
Pořadí 

Topo to raster 

0.5 0.07 0.14 5 

1 0.07 0.15 7 

2 0.09 0.18 10 

5 0.15 0.21 19 

TIN 

0.5 0.05 0.07 1 

1 0.06 0.08 3 

2 0.08 0.13 8 

5 0.10 0.10 12 

Spline 

0.5 0.09 0.25 9 

1 0.10 0.26 11 

2 0.11 0.24 16 

5 0.22 0.45 20 

Kriging 

0.5 0.06 0.09 2 

1 0.06 0.11 4 

2 0.07 0.12 6 

5 0.11 0.13 15 

IDW 

0.5 0.11 0.18 14 

1 0.10 0.15 13 

2 0.12 0.20 17 

5 0.13 0.13 18 

Tabulka 2: Přehled interpolačních metod testovaných na datech z roku 2015 

 

Na prvním a třetím místě podle hodnot RMSE se umístila metoda nepravidelné 

trojúhelníkové sítě (TIN) pro 0,5 m rastr a 1 m rastr. Opět se jeví velmi dobře 

i po vizuální stránce.  

Druhé místo dle RMSE patří metodě Kriging pro 0,5 m rastr, která využívá 

pro interpolaci geostacionární metody odhadu. Po vizuální stránce se Kriging 

v tomto případě jeví velmi podobně jako TIN. Srovnání obou metod je znázorněno 

na Obrázku č. 22. 
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Obrázek 22: Srovnání metod TIN a Kriging pro 0,5 m rastr na datech z roku 2015 

 

4.5. Množství sedimentu v nádrži 

Míru zanesení nádrže bylo možné stanovit na základně znalosti DMT z doby 

napuštění nádrže a DMT z dnešní doby. Pro jejich tvorbu byla vybrána nejideálnější 

interpolační metoda a z vytvořených DMT byly spočítány objemy pro stanovenou 

nadmořskou výšku. Rozdíl těchto objemů je roven objemu sedimentů, které se 

za roky provozu v nádrži zachytily. Pro prostorovou analýzu míry zanesení 

sedimenty budou porovnány oba reliéfy dna.  

Tabulky č. 3 a 4 zobrazují přehled objemů a ploch vypočítaných pro jednotlivé 

interpolační metody, které byly vybrány do užšího výběru na základě RMSE. 

Pro porovnání byla přidána i metoda Spline, která sice vykazovala výborné hodnoty 

RMSE, ale po vizuálním prozkoumání naprosto nevyhovovala. Výpočet objemu 

ukázal, že tato metoda nadhodnocuje objem o více jak 15000 m3 a nebyla tak 

započítána do průměrného objemu.  
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Název interpolace 
rozlišení 

rastru [m] 
RMSE 

objem v 

[m3] 

plocha 

[m2] 

Spline 0,5  0.05 317827 67629 

TIN 0,5  0.05 297793 64901 

Kriging 0,5  0.05 299706 64943 

Spline 1 0.06 315093 67493 

Kriging 1 0.06 299607 64936 

TIN 1 0.07 297702 64894 

Průměrný objem/plocha [m3/m2] 299035 64927 

Tabulka 3: Objem a plocha v roce 1906 

 

Název interpolace 

rozlišení 

rastru 

[m] 

RMSE 
objem v 

[m3] 

plocha 

[m2] 

TIN 0,5  0.05 278787 62865 

Kriging 0,5  0.06 279760 62845 

TIN 1 0.06 278716 62860 

Kriging 1 0.06 279703 62841 

Topo to raster 0,5  0.07 279988 63247 

Topo to raster 1 0.07 279198 63132 

Průměrný objem/plocha [m3/m2] 279088 62857 

Tabulka 4: Objem a plocha v roce 2015 

 

4.6. Odchylka interpolace 

Velikost objemu je zatížena chybou, která je dána průměrnou odchylkou validačních 

a interpolovaných dat (součet odchylek bez absolutních hodnot). V atributové 

tabulce obou datových sad byl přidán sloupec “odchylka“, kde byl vypočítán přes 

Field Calculator rozdíl hodnot validačních a interpolovaných dat. Přes funkci 

Statistics byla zjištěna suma těchto odchylek (proti RMSE sečteny kladné i záporně 

hodnoty a výsledná suma představuje kladnou nebo zápornou odchylku). Odchylka 

byla vydělena počtem měření validačních bodů (200), čímž byla zjištěna průměrná 

odchylka interpolační metody každého bodu (Tabulka č. 5). Záporná hodnota (-18 

mm), která vyšla u datové sady 1906, znamená, že interpolační metoda 
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podhodnocuje nadmořské výšky. Nadhodnocování nadmořských výšek (+24mm) 

vyšlo u datové sady 2015.  

Pro vyhodnocení těchto chyb byla od všech interpolovaných bodů odečtena tato 

průměrná odchylka (v případě dat 2015 přičtena) a následně byl vypočítán objem 

nádrže. Rozdíl objemů činil 1203 m3 pro datovou sadu 1906 a 1431 m3 pro datovou 

sadu 2015 (Tabulka č. 6).  

 

 

Tabulka 5: Součet odchylek bez absolutních hodnot pro výpočet průměrné chyby interpolace 

 

Datová sada 1906 

Název 

interpolace 

rozlišení 

rastru [m] 
objem [m3] 

objem s 

obchylkou -

0,018 m [m3] 

TIN 0,5  297793 298996 

Odchylka celkového objemu nádrže [m3] 1203 

Odchylka celkového objemu nádrže [%] 0.40 

Datová sada 2015 

Název 

interpolace 

rozlišení 

rastru [m] 
objem v [m3] 

objem s 

obchylkou 

0,024 m [m3] 

TIN 0,5  278787 277357 

Odchylka celkového objemu nádrže [m3] 1431 

Odchylka celkového objemu nádrže [%] 0.51 

Tabulka 4: Výpočet celkové odchylky měření na základě výpočtu objemů 

 

 

Název 

interpolace
rozlišení rastru [m]

Součet 

odchylek

Název 

interpolace
rozlišení rastru [m]

Součet 

odchylek

TIN 0,5 -9.97 TIN 0,5 4.50

Kriging 0,5 -0.93 Kriging 0,5 5.07

Kriging 1 0.02 TIN 1 4.68

-3.63 4.75

-0.018 0.024

Datová sada 1906 Datová sada 2015

Průměrná odchylka celková [m] Průměrná odchylka celková [m]

Průměrná odchylka jednoho bodu [m] Průměrná odchylka jednoho bodu [m]
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4.7. Vizualizace 

Na základě srovnání interpolačních metod byly pro vizualizaci vybrány rastry 

generované přes TIN v rozlišení 0,5 m pro obě datové sady. Na Obrázku č. 23 byl 

porovnán reliéf dna z roku 1906 a z roku 2015, ze kterého je patrné zanášení 

v oblasti přítoku (spodní část obrázku) a také změny v horní části nádrže. 

4.7.1. Porovnání reliéfů dna  

 

Obrázek 23: Srovnání reliéfů dna z roku 1906 a 2015 

 

Obrázek 24: Srovnání reliéfů dna z roku 1906 a 2015 ve 3D 
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Mocnost sedimentu byla vygenerována pomocí nástroje “Minus“, který odečte dva 

rastry a každému pixelu přidělí hodnotu rozdílu (opět použity rastry vytvořené z TINu 

o rozlišení 0,5 m). Za provoz nádrže se nejen změnil objem nádrže, ale postupným 

zanášením se také zmenšila plocha volní hladiny (Obrázek č. 25).  

 

 

Obrázek 25: Prostorové rozložení sedimentu za 109 let provozu VD Fojtka  
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5. Výsledky práce 

 

Výsledkem práce je analýza reliéfu dna vlivem zanášení, která poskytuje informace 

o změnách objemu a plochy zátop. Tyto změny jsou rovněž vypočítány 

a vizualizovány na základě vyhodnocení interpolačních metod, které jsou 

proměnlivě přesné v závislosti na typu vstupních dat. Přehled interpolačních metod 

znázorňuje tabulka č. 7.  

Datová sada 1906 

Název interpolace 
rozlišení 

rastru [m] 
RMSE objem v [m3] plocha [m2] 

TIN 0,5  0.05 297793 64901 

Kriging 0,5  0.05 299706 64943 

Kriging 1 0.06 299607 64936 

Průměrný objem/plocha 299035 64927 

Datová sada 2015 

Název interpolace 
rozlišení 

rastru [m] 
RMSE objem v [m3] plocha [m2] 

TIN 0,5  0.05 278787 62865 

Kriging 0,5  0.06 279760 62845 

TIN 1 0.06 278716 62860 

Průměrný objem/plocha 279088 62857 

Tabulka 5: Vyhodnocení třech nejpřesnějších interpolací dle RMSE 

 

Na základě vyhodnocení interpolačních metod byly vybrány tři nejpřesnější 

interpolace skrze RMSE, ze kterých byly vypočítány objemy pro obě datové sady 

(1906 a 2015). Tyto objemy byly spočítány ke kótě hladiny 392,1 m n. m., jelikož 

tato výška reprezentuje celkový ovladatelný prostor nádrže. Dle oficiálních 

charakteristik m n. m.) jako 291 tis. m3, což je patrně hodnota převzatá z projektové 

dokumentace z roku 1906 (tato hodnota se v původních materiálech skutečně 

vyskytuje) a tím pádem je uváděn objem nezanesené nádrže.  

Aritmetickým průměrem objemu vypočtených ze třech interpolací, které byly 

vyhodnoceny jako nejpřesnější pro datovou sadu z roku 1906, bylo zjištěno, 

že skutečný objem nezanesené nádrže byl o 8,035 tis. m3 vyšší než deklarovaná 
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hodnota (291 tis. m3 proti 299,035 tis m3). Nyní bylo na místě srovnat objem 

nezanesené nádrže s objemem ze současnosti (listopad 2015). Pro současná 

měřená data byly vybrány opět 3 nejpřesnější interpolace, ze kterých byly spočítány 

objemy a ty následně zprůměrovány. Za 109 let od napuštění nádrže se zmenšil 

objem nádrže o 19947 m3 (6,7%), což vychází v průměru na 183 m3 sedimentu 

ročně.  

Vlivem zanášení a abraze břehů se v průběhu existence nádrže změnila břehová 

linie a zmenšila se zaplavená plocha. Dle výpočtů jde o zmenšení o 2070 m2 

(Tabulce č. 7, Obrázek č. 25 v kap. č. 4).  
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6. Diskuze 

 

Základním podkladem pro zpracování celé práce byla projektová dokumentace 

z doby výstavby. VD Fojtka spadá pod Povodí Labe, závod Jablonec nad Nisou, kde 

mi byla vyhověna žádost o návštěvu archivu. V archivu jsem dohledal vrstevnicovou 

mapu z roku 1906, která byla dostatečně podrobná pro další zpracování (krok 

vrstevnic 0,5 m). V případě měření stavu sedimentů na VD Vrchlice byla použita 

a následně vektorizována mapa s krokem vrstevnic 1 m (Dostál a kol., 2003). 

Nejdříve jsem se pokusil o automatickou vektorizaci přes nástroj ArcScan, která 

ovšem vykazovala, i vzhledem ke kvalitě fotografie, velmi špatné výsledky. Rozhodl 

jsem se pro časově náročnější, ale za to přesnější metodu -  manuální vektorizaci. 

Z důvodu zpřesnění dat jsem vektorizoval i návodní část hráze, která pod vodou 

zaujímá nezanedbatelný objem. Pro téměř všechny intepolační metody obsažené 

v softwaru ArcGIS (až na metodu Topo To Raster) je požadována bodová vrstva. 

Provedl jsem tedy konverzi vrstevnic na body pomocí nástroje “Feature Vertices To 

Points“, avšak jsem zjistil, že nástroj převádí pouze tzv. vertex body (body zlomu 

z vektorizování), což jsem zhodnotil jako zbytečnou ztrátu kvality dat. Pro účely této 

práce jsem vyvinul skript a následně nástroj v programovacím jazyce Python (dle 

Jennings 2011), který rozdělí linie, v tomto případě vrstevnice podle požadovaného 

kroku. Jako dostatečnou přesnost jsem zvolil krok na rozdělení linií na 1 m. Touto 

úpravou vzniklo z vrstevnic celkem 7500 bodů, které jsem použil jako vstupní data 

pro interpolační metody. Po této úpravě jsem narazil na problém s nepřesností 

výškového systému vektorizovaných map a systému dnešního (Balt po vyrovnání). 

Šlo o jadranský výškový systém, která se liší od Bpv. o 40 cm. Od každého bodu 

jsem tedy musel odečíst 40 cm pro srovnání výškových systémů. Kubinský a kol 

2013 použil pro srovnání výškového systému hodnotu 46 cm, jelikož se nádrž 

nachází na Slovensku.   

Dále jsem vyhodnocoval míru aktuálního zanesení nádrže na základě vlastního 

měření echosounderem M9 z lodi. Echosounder M9, který jsem měl k dispozici, je 

přístroj určený především k měření průtoků na tocích, ale velmi přesně měří 

i hloubky, jak uvádí Hradilek a kol. 2015. Data jsem najel na kajaku během 90 minut, 

kdy každou vteřinu vznikl jeden bod. Bohužel vodní hladina nádrže byla v době 

měření velmi nízko, což mi neumožnilo naměřit body v blízkosti břehové linie 

za běžného stavu. Břehovou linii jsem se snažil naměřit GPS přístrojem, 

ale v požadované polohové i výškové přesnosti se mi podařilo naměřit pouze 30 
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bodů. Bylo to způsobeno velkým množství stromů a strmým terénem v okolí nádrže. 

Ideálním řešením by bylo naměření břehové linie a blízkého okolí nádrže pomocí 

totální stanice, která není závislá na příjmu GPS signálu. Problém jsem vyřešil 

použitím 5G dat z WMS služby ČUZK. Tuto vrstvu jsem převedl na body a použil 

jsem je pro zobrazení břehů pro přesnější následnou interpolaci. Nejdůležitější 

ovšem byla přesná hodnota nadmořské výšky hladiny v době měření (kterou jsem si 

naměřil pomocí GPS), jelikož echosounder měří hloubky a ne nadmořské výšky.  

Vznikla tak vrstva čítající 5500 bodů naměřených echosounderem a dalších více jak 

5000 bodů okolí nádrže. Kubinský a kol 2013 naměřili na nádrži Velká Rychňavská 

4747 bodů. Rozloha této nádrže byla větší než VD Fojtka, což znamená mnohem 

vyšší hustotu bodů v případě mého měření. Povodí Labe sice provedlo v roce 2010 

rovněž měření echosounderem na VD Fojtka, ale počet naměřených bodů na nádrži 

byl pouze 100 a ještě při relativně vysoké odchylce. Původně mělo být toho měření 

zahrnuto v této práci a porovnáno s ostatními výstupy, ale jeho hustota a přesnost to 

vylučuje (Dost a Mannaerts 2008 zmiňují důležitost opakované batymetrie nádrží, 

který je důležitým podkladem pro management povodí). 

Z dat z vlastního měření jsem si mohl dovolit generovat rastery v rozlišení až 0,5 m, 

které dle mého očekávání podávaly nejlepší výsledky. Vítězství interpolace 

odvozené z TINu právě v půlmetrovém rozlišení u obou datových sad je zapříčiněno 

právě velkou hustotou dat. V případě menší hustoty dat by TIN poskytoval horší 

výsledky než ostatní interpolace, jelikož TIN nijak neredukuje extrémní hodnoty 

(Walsh 2010). Problematické se zdá i vyhodnocení interpolací zejména v místech 

s většími sklony, kde není možné naměřit data. Dle RMSE poskytovala původně 

nejlepší výsledky metoda Spline, jenže po vizuální kontrole jsem ji musel úplně 

vyřadit právě z důvodu extrémních hodnot, které se vygenerovaly v oblasti s vyšším 

sklonem a mimo měřenou oblast. Z toho důvodu je nezbytné udělat vizuální kontrolu 

všech interpolovaných metod, než se z nich budou generovat další výpočty 

a vizualizace.  

Zanesení sedimenty VD Fojtka vykazuje velmi malé hodnoty (6,7 % za 109 let), 

jelikož vodní nádrže v ČR jsou zaneseny sedimenty průměrně až z jedné třetiny. Jak 

popisuje Kubinský a kol 2013, zanesení nádrže může dosahovat až 56,7 % na 

nádrži Velká Richňavská. V Turecku v nádrži Altinapa došlo během 42 let ke snížení 

zásobní kapacity o 33,4 % (Ceylan a kol 2011). Velký vliv na zanášení má předzdrž 

umístěná nad nádrží. Na Halčianské vodní nádrži na Slovensku dochází k velkému 

zanášení z důvodu neudržovaných záchytných kazet (Weis a kol. 2014). V případě 
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povodňových stavů na VD Fojtka je však její funkce značně omezená a do dnes 

nebylo známo, jak velké je zanesení samotné nádrže. Předzdrž jsem rovněž 

naměřil, ale data nebylo možné s ničím srovnat, jelikož její tvar a objem 

se v průběhu let měnil. Nádrž je každých 5 let těžena, ale nikde nebylo možné 

dohledat nebo zjistit, kolik sedimentu je z ní těženo. Bylo by velmi zajímavé určit, 

kolik % sedimentu předzdrž zachytí a kolik % pokračuje do samotné přehrady 

Fojtka. Dalším možným výpočtem by bylo stanovení množství sedimentů, které 

projdou přes výpustné zařízení VD Fojtka. Dostál a kol 2003 u VD Vrchlice uvadí, 

že 97 % sedimentů, které se dostanou do nádrže, v nádrži zůstává a pouze 3 % 

odchází dále po toku. V některých částech nádrže by bylo prospěšné zjistit, 

jak se reliéf dna měnil v čase. Sedláček a Bábek 2016 popisují metodu, kdy 

odeberou vzorky dna (vrtná jádra) v délce až 3 m. Tyto vzorky jsou analyzovány 

a dokáží pomocí magnetické susceptibility poskytnout údaje o stratigrafických 

změnách rychle a přesně. Touto metodou lze určit také původ sedimentu v daném 

časovém období. 

Jak bylo uvedeno, informace o těžbě sedimentu z předzdrže nejsou evidovány. 

To vylučuje výpočet celkového množství splavenin z povodí toku Fojtka. Halcrow 

2001 sice uvádí výpočet množství sedimentu zachytávaného v nádržích pomocí 

rovnic vycházejících z využití pozemků na povodí, ale přesnost tohoto výpočtu 

nebyla srovnána se skutečným množstvím usazeným v nádrži. V případě 

nadměrného množství sedimentu přinášeném tokem Fojtka by bylo na místě zajistit 

protierozní opatření v celém jeho povodí. Tím by se zvýšila retenční schopnost 

povodí, snížil odnos půdy, snížily náklady na těžbu sedimentů a také zvýšila kvalita 

vody.  
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7. Závěr 

 

Cílem práce bylo analyzovat změny reliéfu dna a zásobního prostoru přehrady 

Fojtka za 109 let provozu. Tato analýza zahrnovala srovnání interpolačních metod, 

ze kterého byla nejlépe vyhodnocena metoda TIN v půlmetrovém rozlišení.  

Oficiální informace uvádějí objem nádrže 291 tis. m3, což je patrně hodnota 

převzatá z projektové dokumentace z roku 1906. Výpočtem bylo zjištěno, 

že skutečný objem nezanesené nádrže byl 299,035 tis. m3 a současný objem 

nádrže je 279,088 tis. m3. Maximální chyba stanovená k výpočtu objemu nádrže 

byla vyčíslena na 0,4% pro objem z roku 1906 a 0,51% pro objem současný. Za 109 

let od napuštění nádrže se zmenšil objem nádrže o 6,7 % (19947 m3), ročně tedy 

přibude v průměru 183 m3 sedimentu. Vlivem zanášení a abraze břehů 

se v průběhu provozu nádrže změnila břehová linie a zmenšila se zaplavená plocha 

o 3,2 % (2070 m2). 

Pravidelně těžená předzdrž umístěná nad nádrží rapidně zamezuje zanášení 

nádrže sedimenty z povodí potoku Fojtka, což potvrzují výpočty o změnách 

zásobního prostoru. I přes to jsou vlivem zanesení patrné mírné změny morfologie 

dna především na přítoku a také u hráze. 
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9. Přílohy 

 

Obrázek 26: Transport lodi k přehradě 

 

Obrázek 27: Průběh měření na VD Fojtka 
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Obrázek 28: Poloha VD Fojtka 
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Obrázek 29: Srovnání reliéfu dna z doby výstavby s aktuálním stavem 

 

 



53 

 

 

Obrázek 30: Srovnání reliéfu dna z doby výstavby s aktuálním stavem
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Obrázek 31: Mocnost sedimentu na VD Fojtka 
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Obrázek 32: 3D model srovnání reliéfů dna (pohled od hráze) 
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Obrázek 33: 3D model srovnání reliéfů dna (pohled přítoku)


